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1. Disclaimer

The manual contains proprietary information of Doppler Systems LLC.; it is provided under a license agreement 
containing restrictions on use and disclosure and is also protected by copyright law. Reverse engineering of any 
software or hardware is prohibited.

Due to continued product development this information may change without notice. The information and 
intellectual property contained herein is confidential between Doppler Systems LLC. and the client and remains 
the exclusive property of Doppler Systems LLC. If you find any problems in the documentation, please report 
them to us in writing. Doppler Systems LLC does not warrant that this document is error-free.

Doppler Systems radio direction finding equipment and software are designed to help locate the source of 
interfering, emergency or unauthorized transmissions, or others coming from marker and rescue beacons, etc., 
and is not intended to be used as a navigation aid. In particular it is not to be used for aircraft or marine 
navigation.

Doppler Systems warrants that the media on which the Software is distributed will be free from defects for a 
period of sixty (60) days from the date of delivery of the Software to you. Your sole remedy in the event of a 
breach of this warranty will be that Doppler Systems will, at its option, replace any defective media returned to 
Doppler Systems within the warranty period.  Doppler Systems does not warrant that the Software will meet 
your requirements or that operation of the Software will be uninterrupted or that the Software will be 
error-free. 
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2. Glossary

Below are definitions used in this document

· Beacon: A radio transmission source at a known location, transmitting on a known frequency.

· Fixed Site: A direction finder located at a fixed location.

· Intercept: Receipt of a transmitted signal by a direction finder.

· Line of Bearing (LOB): Azimuth angle measured from true north from the site of the direction finder 

to a transmission site (also referred to as a bearing).

· Mission: Settings and parameters in TargetTrack 4 that define the operation of the application

· Mobile Site: Direction finder mounted in a vehicle or vessel.

· Primary Site: Site that controls the data collection.  Audio from the primary site will be recorded and 

saved in the database.

· Target: Estimated location of a radio frequency transmission source 

· Reception: Combination of all intercepts upon receipt of a signal.  If only one site is in use the 

reception consists of only one intercept.  The reception entered in the database contains the date, time, 

frequency of the reception as well as meta data entered by the user.
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3. Introduction

TargetTrack 4 provides geolocation of radio transmission sources using Doppler Systems, LLC radio direction 
finding hardware.  Using an IP network, the software connects to multiple radio direction finders located in a 
geographical area.  When a radio transmission occurs, the direction finders measure bearings to the 
transmission source.  TargetTrack 4

· Works with fixed sites and mobiles
· Facilitates data collection and control of remotely connected direction finders 
· Draws the bearings on a map based display
· Calculates and displays the estimated position of the transmission source
· Records and plays the received audio from the transmission source (target)
· Saves the bearings and recorded audio to a searchable database for later retrieval and playback
· Allows user to define the anticipated geographical area of the transmission source to limit the amount 

of data collected when monitoring busy channels
· Provides user defined search and scan functions allowing monitoring of a range of frequencies.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4



4. Getting Started

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.1. Installation

To install TargetTrack 4 double click on TargetTrack 4.exe and follow the on screen instructions.  The latest 
version of TargetTrack 4 is always available from our web site 
https://dopsys.com/radio-direction-finder-software/direction-finder-downloads/.

When attempting to install you may encounter the following dialog

If you do, press the More info link as shown above and the dialog will change to
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Then press Run anyway as shown above.

Minimum Computer Requirements of Computer

Operating System Windows 10 or higher

Minimum Available Disk Space 50MB

Installed RAM 2 GB

Ethernet 100BaseT

Audio Speaker or Headphones

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.2. License

TargetTrack 4 requires a license key.  If you purchased the software with your direction finder you should have 
been furnished with a key.  If you do not have the key, contact the factory at Doppler Systems. or call 

1-480-488-9755.  Each license will license up to five instances of TargetTrack 4.  The license is typically good 
for one year.  Thirty days prior to expiration, the user will be alerted that license renewal is required.  If the 
license is not renewed, there is a thirty day grace period.  After the grace period expires, TargetTrack 4 will no 
longer run.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.2.1. Activating aLicense

The first time you run the TargetTrack 4 a license dialog will appear as shown below
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Enter the license key and click OK.  If the license key was entered incorrectly the program will exit.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.2.2. Deactivating A License

The TargetTrack 4 license entitles the user to license up 5 computers running TargetTrack 4.  If this maximum 
number has been reached and you would like to license another computer it is necessary to deactivate the 
license on one computer.  To deactivate a license, select Deactivate License from the Help Menu.

Click Yes on the displayed dialog and the license will be removed from the computer.

Once deleted, you can move the license to another computer.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.3. Map

The first time TargetTrack 4 is run, a the display will be similar to what is shown below. A world map will be 
displayed.  If there are any direction finders that are directly connected to the computer or if they are on the 
same local area network as the computer their address and location will be displayed in the lower right hand 
corner of the screen. Note: The first time you run TargetTrack 4 the computer you are using must 
have an Internet connection.
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Next use the Zoom and Pan controls to select the geographical area where you are going to use your Doppler 
radio direction finders.   Pan the map by positioning the mouse on the map and pressing the left mouse button. 
 While holding the left mouse button down move the mouse up or down or to the right or left.  The map will 
pan with the motion of the mouse.  The arrow keys can also be used to pan the map.  Press the Zoom In 
button to zoom in on the area you wish to use.  You can also use the mouse wheel to zoom in and zoom out 
the map.  The screen shot below shows the map zoomed into the Tucson area.
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Once the map is positioned press the Download Map Data button in the upper right corner of the map.  A 
dialog similar to the one shown below will be displayed.  Press OK and the map data will be downloaded and 
saved to your hard disk. This will allow for faster zooming in the future as well as allowing the map to be used 
off line if required.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.4. Adding Direction Finding Sites

TargetTrack 4 requires that the location and IP addresses of the direction finders must be entered into the 
application.  There are two types of direction finder entries: fixed site and mobile.  Repeat the steps given 
below for each direction finder on your network.

To add a site to TargetTrack 4, either click on the Sites tab in the ribbon menu and select Fixed or Mobile from 
the Add Site menu or right click on the map at the location where you want to place the site and select New 
Fixed Site or New Mobile Site from the pop up menu.  

If the direction finder is on the local area network you can right click on the table at the bottom right of the 
screen and select Connect as Fixed Site or Connect as mobile.  The site will be automatically created and placed 
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at the proper location on the screen.

  

The site will appear on the map as shown below.  If it is in the wrong location you can left click on the site and 
drag it to the desired location or you can enter the coordinates of the site on the Sites tab of the ribbon menu.  
If your direction finder has a GPS then the site will be properly positioned once a connection with the direction 
finder is established.

Click on the Sites tab on the ribbon menu and enter the name of the site and the IP address and IP Port.  
Unless you have changed the IP port using MPT User Interface it will be 2101.

Click on the Connect button and if the data entered is correct and the direction finder is on the network, the 
site will appear as shown below.
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You change the size of the site and the color of it by left clicking on the site and selecting Size and Color on the 
Sites tab of the ribbon menu.  If you hear static in the speaker and you are not tuned to a signal source 
increase the squelch setting on the Home tab to eliminate the noise.

If you are not using a GPS with the direction finder, it is recommended that you next press the lock button for 
the site.  This will prevent the accidental repositioning of the site.  If you need to move the site you can press 
the button again to unlock it.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.5. Calibrating a Fixed Site Direction Finder

Each fixed site direction finder must be calibrated prior to using it.  Calibration requires a radio frequency 
transmission source at a known frequency and location referred to as a Beacon.  If the direction finder is going 
to be used over a limited angle it is best to use a beacon near the center of the desired range of bearings.

To place a beacon on the map select Beacon from the Add Site menu on the ribbon menu or right click on the 
map and select New Beacon.

       

Position the beacon on the map by left clicking on the beacon icon and dragging it to the desired location.  On 
the Sites tab enter the name of the beacon and its frequency.

    

Press the Lock button to avoid accidentally moving the beacon at a later time.
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Once the beacon is positioned click on the site you wish to calibrate and select the beacon you want to 
calibrate to from the Calibrate To drop down menu.

The software will tune the receiver to the frequency of the beacon and then perform the calibration.  It is best 
to tune the receiver to the beacon frequency to check the calibration.  If the calibration is not correct repeat it.  
The figure below shows the display of a calibrated site

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.6. Mobile Direction Finder

Use the exact same procedure as shown above to add a mobile site to the map.  However, there is no need to 
calibrate a properly installed mobile.  The mobile system is factory calibrated.  

Once the mobile site is added to the map it is necessary to drive in a straight line for about 20 meters in order 
for the GPS receiver to establish a heading.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.7. Setting the Frequency

To tune the direction finders to the desired frequency, select the Home tab on the ribbon menu.  The frequency 
can be entered by typing in the desired frequency or by pressing the increase frequency or decrease frequency 
buttons.  All of the direction finders on the network will be set to the same frequency.
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Enter Frequency

Type in the desired direction finding network frequency in MHz

Increase Frequency

Pressing this button increases the frequency by the tuning step.

Decrease Frequency

Pressing this button decreases the frequency by the tuning step

Tuning Step

Use this drop down to adjust the tuning step

Primary Site Squelch Setting

Sets the primary site's receiver squelch

Add Frequency to Channel Menu

Press + to save the currently tuned frequency to the Channels menu

Remove Frequency from Channel Menu

Press - to remove the channel displayed in the Channel menu from the Channel menu

Channel Menu

Select a channel to tune the receiver to.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.8. Receiving a Bearing

When a signal is received by the Primary site receiver bearing lines will be drawn on the map and the intercept 
display will show that a signal is being received.  The figure below is an example of a received bearing.
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4.9. Geolocating a Transmission Source

Geolocating a transmission source requires at least two and preferably three or more radio direction finders 
located in the area of the transmission source.  The Site Location for Optimal Triangulation application note 
discusses the siting of direction finders for optimal triangulation.  Obviously due to location restrictions the 
optimal locations cannot be achieved, however, the application note can be used to provide guidance on 
locating the radio direction finders.

Prior to performing geolocation, add the direction finders to be used onto the map as described in Adding 
Direction Finding Sites and calibrate the added sites per Calibrating a Fixed Site Direction Finder.

Once all the sites are connected and calibrated, tune the direction finder to the desired frequency.  When a 
transmission occurs, the display will resemble the one shown below.
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Displayed Bearings
Bearings from each site that are currently shown on the display

Estimated Target Position
Estimate position of the transmission source

Uncertainty Ellipse
Ellipse indicating that the target has a 95% probability that it is within this elliptical area

Estimated Target Position
Coordinates of the estimated target position

Circular Error Probability
Radius of a circle around the target that predicts target has a 95% probability that it is within this radius about 
the estimated target position 

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.10. Playback of Recorded Reception

Each time the direction finders receive a signal, a reception is created and entered into a database.  The 
recorded receptions can be accessed using the reception controls or by searching the database.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.10.1. Reception Control

The reception control appears at the bottom of the display.  Explanations of each controls functions are given 
below.
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Zoom In

Halves the time span of the display

Zoom Out

Doubles the time span of the display

Move Back

Repositions the time back 1 hour

Previous

Plays the previously recorded reception

Pause/Play

Pauses or resumes the playback of the data

Next

Plays the next recorded reception

Current

Moves the time to the current time

Delete

Deletes the selected reception

Currently Recording Reception

Displays the currently recording reception in blue
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Previously Recorded Reception

Previously recorded receptions are displayed in green

Play Time

Play time displays the time of the currently playing reception.  This time can be manually set by clicking on it 
and entering the date and time as shown below.

UTC/Local

Click on this item to toggle between Local time and UTC time

Enable/Disable Recording

Enables/Disables writing to the database

Span

Displays and sets the time span of the reception display

The play time also be set by double clicking anywhere on the time line.  The location of the double click will set 
the time.

Receptions can be played, edited, or deleted by right clicking on the reception and selecting Play, Edit, or 
Delete as shown below

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.10.2. Reception Display

On the right side of the screen is a display of the recent receptions.  To playback a given rescption simply 
double click on it.
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To edit the reception or delete the receipt, right click on it and select the desired action.

Selecting Edit will display the following dialog allowing the user to enter meta data describing the reception.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

4.10.3. Bearing List

On the left side of the screen the bearings for the reception are shown.  Clicking on the bearing will move the 
playback timeline to that bearing
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4.10.4. Database

Each reception is entered in a database.  To playback or edit the meta data for the reception, click on the 
database tab on the ribbon menu.

The database can be searched by date and time, by frequency or by the user parameters shown above.  To 
initiate a search enter the desired parameters and press the Search button.  If no parameters are entered, 
every reception in the database will be displayed.  An example of parameterless search is shown below.
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Clicking on an entry in the results allows the user to play or edit the reception.  To play the reception simply 
press Play Selected or double click on the reception and the it will be played back on the display.
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5. Mobile Operation

TargetTrack 4 can be used for mobile direction finding as well as fixed site.  A mobile direction finder requires a 
GPS receiver that outputs NMEA GPGGA and GPVTG messages once per second.  Doppler recommends Garmin 
16 or Garmin 18 GPS receivers.  The GPS must be connected to the direction finding processor using a 
USB-to-Serial converter.  Doppler recommends a FTDI based USB-to-Serial device.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

5.1. Preparing the Computer

Typically when using TargetTrack 4 in a mobile application the a laptop computer is connected to the direction 
finder using a crossover cable which is supplied with the direction finder (some computers are auto sensing and 
do not require a crossover cable).  Once connected the computer's Ethernet adapter must be configured to 
connect directly with the direction finder.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

5.1.1. Windows 11 Adapter Setting Instructions

To configure the Ethernet adapter on Windows 11, first type Settings in the Windows Start menu.

On the left side of the displayed screen select Network & internet
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Click on Advanced network settings
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Click on the down arrow next to the Ethernet adapter you are using to connect to the direction finder
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Click on View additional properties

Click Edit
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Change the settings to the settings shown below and press Save
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5.1.2. Windows 10 Adapter Setting Instructions

To change the adapter settings in Windows 10 select Settings from the Windows Start menu
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Click on Network & Internet and select Ethernet on the right side of the displayed window. 

Press Change adapter settings
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Right click on the Ethernet adapter's name and select Properties

Select Internet Protocol Version 4 (TCP/IPv4) and then press the Properties button
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Choose the Use the following IP address and enter an IP address of 10.0.0.1 and a subnet mask of 255.0.0.0 
and press OK.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

5.2. Adding a Mobile Site

To initiate a mobile mission, select New Mission from the File menu.  To add a mobile site go to the Site tab on 
the ribbon menu and select Mobile from the Add Site menu or right click on the map and select New Mobile Site 
from the pop up menu.

The site will appear on the map with an X through it.  
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On the Site tab enter the IP address of the direction finder and the IP Port. and press Connect

Once connected the site will appear as shown below

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

5.3. Establishing a Heading

Accurate mobile direction finder bearings require an accurate heading from the GPS.  To establish a heading 
move the direction finding vehicle in a straight line for about 20 meters.  When a heading is established the 
arrow representing the mobile on the map will point in the direction of the heading.

Once a heading is established the application will display the LOB properly on the map.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

5.4. Mobile Targeting

Finding a transmission source using the mobile requires multiple bearing measurements from multiple 
locations.  To achieve this you must save the mobile locations on the map.  TargetTrack 4 uses the saved 
locations to calculate the location of the transmission sources.

To save a mobile location and bearing press the Insert Mobile button the on Home tab of the ribbon menu, 
press the Insert key on the keyboard, double click on the site on the map, or type Ctrl-I on the keyboard.  This 
will lock the position of the mobile on the map.

Next drive to another location and wait for a transmission.  When the next transmission is received insert that 
location.  Once two locations are inserted TargetTrack 4 will calculate an estimated target location.
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An inserted location can be deleted by clicking on it and pressing the delete key on the keyboard or by right 
clicking on the inserted site and selected Delete from the menu.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

5.5. Compass Rose Display

In a typical mobile application the user wants to drive to the transmission source.   When the vehicle is getting 
close to the target it is best to use a compass rose display.  The compass rose display displays the bearing 
relative to the vehicle rather that to true north like it is shown on the map.  This allows the user to direct the 
vehicle operator to drive in the direction indicated by the display.  To activate the compass rose display press 
the Show Compass Rose button on the Home tab of the ribbon menu.

The figure below shows a sample of the compass rose overlayed on the map.
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6. Mapping

The mapping engine in TargetTrack 4 is based on the open source software GMap.net.  It allows the user to 
use a number of different Internet map data providers. 

Panning
To pan the map place the mouse over the map, press the left mouse button, and drag the map to desired 
location.  You can also use the up, down, right, and left arrow keys to pan the map.

Zooming
Zoom the map using the zoom controls on the right side of the map, or you can use the mouse wheel to zoom 
in or out.

Refer the the figure below for an explanation of the map operation.

Map Provider Menu

The map provider menu allows the user to select what map provider to use.  The default map map providers 
are shown below.  Other providers can be added using the Options menu.

Map Options Menu

The Options menu is shown below.
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Select Providers

To add additional map providers or to remove map providers from the Map Providers menu, click on 
Select Providers.

The following dialog will be displayed.

Move Map to Selectable Maps List

To add maps to the Map Provider menu click on a map in the Available Maps list and press this 
button.

Remove Map From Selectable Maps List

To remove a map from the Map Providers menu click on the map in the Selectable Maps list and press 
this button

Import and Export Maps

Map data can be exported to a file and imported as needed.

Cursor Location

Displays the location of the cursor on the map.
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Coordinate Format

Sets the coordinate system format for TargetTrack 4.

Zoom In

Zooms in the map one level.

Zoom Out

Zooms out the map one level.

Previous View

Returns to the previous view of the map after zooming or panning.

Download Map Data

To use the map data off line it is necessary to cache the maps on the local computer.  The can be accomplished 
by pressing this button

After you press the button a dialog similar to the on shown below will be shown

Press OK and the map data will be downloaded.
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7. Editing Site Parameters

To edit the parameters of a site, left click on it. Then select the Sites tab on the ribbon menu as shown below

Delete

Press Delete Site to remove the selected site from the map.  The site can also be deleted by selecting it and 
pressing the Delete key on the keyboard.

Site Name

Enter the name to use for the site.  It is recommended to use a descriptive name such as the location of the site.

IP Address

Enter the IP address of the site

IP Port

Enter the IP port used by the site.  The IP port number will always be 2101 unless it has been changed using 
the MPT User Interface Software

Site Location

Enter the latitude and longitude of the site.  The location of the site can also be changed by dragging the site to 
a new location on the map.

Coordinate Format

The coordinate format can be set to Decimal, Degrees-Minutes, Degrees-Minutes-Seconds, or MGRS

Lock Site Position

Press the lock button to prevent the user from accidentally moving the site.  To release the lock press the 
button again.

Change site size and color

Change the size and/or color of the displayed site on the map
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8. Direction Finder Settings

In nearly all cases the default settings of the direction finder will be adequate.  However, for special cases 
TargetTrack 4 provides a means of changing the settings.  For an explanation of these settings see the MPT 
User Interface manual.

The one exception to the above statement is the squelch control.  If a non primary site is displaying random 
bearings it is probable that the receiver squelch is open. The squelch can be adjusted using the squelch slider 
or by entering a value for the squelch (0 - 255) in the squelch value text box. Tune TargetTrack 4 to a 
frequency where you know there is no signal.  Increase the squelch level until the bearings are no longer being 
displayed.  If you wish to listen to the audio from the site while adjusting the squelch, you can temporarily 
make the site the primary site by pressing the Make Primary button on the Site tab of the ribbon menu.

Some direction finder settings can be changed from TargetTrack 4 by selecting Direction Finder tab on the 
ribbon menu as shown below
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9. Database Operation

The TargetTrack 4 database records every reception.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

9.1. Search

The database contains all the receptions recorded by TargetTrack 4.  It is searchable using the parameters 
entered into the Database tab on the ribbon menu.  Adding meta data (Frequency, Subject, Priority, and 
Keywords) can aid in the search by limiting the possibilities.

The figure below shows the Edit Reception dialog.  
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Meta data (Priority, Subject, Keywords, and Comments) can be entered for the reception.  Keywords need to be 
separated by commas.  Once the meta data is entered press Save.  Now the database can be searched on the 
meta data entered.

Your can also delete one or more receptions by selecting the receptions and pressing the Delete Selected 
button. You can also search on a field and then press Select All and delete or export all data associated with 
the search. 

If these are not receptions of interest then they can be deleted. 

TargetTrack Files
Files saved in .ttdf format can be imported into a TargetTrack 4 database so they can be deleted and restored 
at a later time if needed or they can be imported to a different computer running TargetTrack 4.
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9.2. Exporting Data

You can export selected receptions so they can be imported into another TargetTrack database on a different 
computer or so they can be archived.  The search results below show a search on the database over a date 
range from 3/1/2025 to 3/21/2025

Selected all these results and pressing the Export Selected button will export the data to a user selected file.  
The data can be exported in one of three formats: ttdf (Doppler db format), JSON, and XML.  After pressing the 
Export Selected button the following dialog will appear:
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Select the desired format and press Save.  

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

9.2.1. JSON Schema

JSON Schema
If saved as a json document the JSON schema is as listed below. The AudioData is a mp3 file encrypted as a 
Base64 string.
{
  "$schema": "http://json-schema.org/draft-07/schema#",
  "type": "array",
  "items": {
    "type": "object",
    "properties": {
      "Transcript": {
        "type": "object",
        "properties": {
          "ID": { "type": "integer" },
          "Comments": { "type": ["string", "null"] },
          "Subject": { "type": ["string", "null"] },
          "Keywords": { "type": ["string", "null"] },
          "StartTime": { "type": "integer" },
          "EndTime": { "type": "integer" },
          "SiteList": { "type": "string" },  // JSON-encoded string
          "Frequency": { "type": "number" },
          "SystemName": { "type": "string" },
          "Priority": { "type": "integer" },
          "Start": { "type": "string", "format": "date-time" },
          "End": { "type": "string", "format": "date-time" }
        },
        "required": [
          "ID", "StartTime", "EndTime", "SiteList", "Frequency",
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          "SystemName", "Priority", "Start", "End"
        ]
      },
      "Intercepts": {
        "type": "array",
        "items": {
          "type": "object",
          "properties": {
            "Intercept": {
              "type": "object",
              "properties": {
                "DirectionFinderSerialNumber": { "type": "string" },
                "DirectionFinderFirmwareVersion": { "type": "string" },
                "ID": { "type": "integer" },
                "BearingStartTime": { "type": "integer" },
                "BearingEndTime": { "type": "integer" },
                "AudioStartTime": { "type": "integer" },
                "AudioEndTime": { "type": "integer" },
                "Bearings": { "type": "string" }, // JSON-encoded string
                "Audio": { "type": ["string", "null"] },
                "Frequency": { "type": "number" },
                "TranscriptID": { "type": "integer" }
              },
              "required": [
                "DirectionFinderSerialNumber", "DirectionFinderFirmwareVersion",
                "ID", "BearingStartTime", "BearingEndTime", "AudioStartTime",
                "AudioEndTime", "Bearings", "Frequency", "TranscriptID"
              ]
            },
            "AudioData": { "type": "string" }
          },
          "required": ["Intercept", "AudioData"]
        }
      }
    },
    "required": ["Transcript", "Intercepts"]
  }
}
The JSON schema for the SiteList is

{
  "$schema": "http://json-schema.org/draft-07/schema#",
  "type": "array",
  "items": {
    "type": "object",
    "properties": {
      "ID": { "type": "integer" },
      "Name": { "type": "string" },
      "IPAddress": { "type": "string" },
      "IPPort": { "type": "integer" },
      "AudioIPPort": { "type": "integer" },
      "SerialNumber": { "type": "integer" },
      "Type": { "type": "string" },
      "Latitude": { "type": "number" },
      "Longitude": { "type": "number" },
      "Frequency": { "type": "number" },
      "Color": { "type": "string" },
      "Receiver": { "type": "string" },
      "IsPrimary": { "type": "integer" },
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      "Size": { "type": "integer" },
      "HardwareVersion": { "type": "string" },
      "SoftwareVersion": { "type": "string" }
    },
    "required": [
      "ID", "Name", "IPAddress", "IPPort", "AudioIPPort", "SerialNumber",
      "Type", "Latitude", "Longitude", "Frequency", "Color", "Receiver",
      "IsPrimary", "Size", "HardwareVersion", "SoftwareVersion"
    ]
  }
}
The JSON schema for the Bearings is
{
  "$schema": "http://json-schema.org/draft-07/schema#",
  "type": "object",
  "properties": {
    "IsAverage": { "type": "boolean" },
    "BearingColor": { "type": "string" },
    "DFName": { "type": "string" },
    "Frequency": { "type": "number" },
    "Id": { "type": "integer" },
    "Value": { "type": "number" },
    "RSSI": { "type": "integer" },
    "RandomStdDev": { "type": "number" },
    "StdDev": { "type": "number" },
    "Averages": { "type": "integer" },
    "AudioLevel": { "type": "integer" },
    "Latitude": { "type": "number" },
    "Longitude": { "type": "number" },
    "Time": { "type": "string", "format": "date-time" },
    "TimeUTC": { "type": "string", "format": "date-time" },
    "RotDirection": { "type": ["string", "integer"] },
    "Heading": { "type": "number" }
  },
  "required": [
    "IsAverage", "BearingColor", "DFName", "Frequency", "Id", "Value",
    "RSSI", "RandomStdDev", "StdDev", "Averages", "AudioLevel",
    "Latitude", "Longitude", "Time", "TimeUTC", "RotDirection", "Heading"
  ]
}

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

9.2.2. XML Schema

XML Schema
If saved as an XML document the XML schema is as listed below.  The AudioData is a mp3 file encrypted as a 
Base64 string.

<?xml version="1.0" encoding="utf-8"?>
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema">
  <xs:element name="ArrayOfXMLTranscriptExport">
    <xs:complexType>
      <xs:sequence>
        <xs:element name="XMLTranscriptExport" maxOccurs="unbounded">
          <xs:complexType>
            <xs:sequence>
              <xs:element name="Intercepts">

43



                <xs:complexType>
                  <xs:sequence>
                    <xs:element name="XMLReceivedIntercept" maxOccurs="unbounded">
                      <xs:complexType>
                        <xs:sequence>
                          <xs:element name="Intercept">
                            <xs:complexType>
                              <xs:sequence>
                                <xs:element name="DirectionFinderSerialNumber" type="xs:string"/>
                                <xs:element name="DirectionFinderFirmwareVersion" type="xs:string"/>
                                <xs:element name="ID" type="xs:int"/>
                                <xs:element name="BearingStartTime" type="xs:long"/>
                                <xs:element name="BearingEndTime" type="xs:long"/>
                                <xs:element name="AudioStartTime" type="xs:long"/>
                                <xs:element name="AudioEndTime" type="xs:long"/>
                                <xs:element name="Frequency" type="xs:double"/>
                                <xs:element name="TranscriptID" type="xs:int"/>
                                <xs:element name="BearingList">
                                  <xs:complexType>
                                    <xs:sequence>
                                      <xs:element name="BearingModel" maxOccurs="unbounded">
                                        <xs:complexType>
                                          <xs:sequence>
                                            <xs:element name="IsAverage" type="xs:boolean"/>
                                            <xs:element name="BearingColor">
                                              <xs:complexType>
                                                <xs:sequence>
                                                  <xs:element name="A" type="xs:int"/>
                                                  <xs:element name="R" type="xs:int"/>
                                                  <xs:element name="G" type="xs:int"/>
                                                  <xs:element name="B" type="xs:int"/>
                                                  <xs:element name="ScA" type="xs:float"/>
                                                  <xs:element name="ScR" type="xs:float"/>
                                                  <xs:element name="ScG" type="xs:float"/>
                                                  <xs:element name="ScB" type="xs:float"/>
                                                </xs:sequence>
                                              </xs:complexType>
                                            </xs:element>
                                            <xs:element name="DFName" type="xs:string"/>
                                            <xs:element name="Frequency" type="xs:double"/>
                                            <xs:element name="Id" type="xs:int"/>
                                            <xs:element name="Value" type="xs:double"/>
                                            <xs:element name="RSSI" type="xs:int"/>
                                            <xs:element name="RandomStdDev" type="xs:double"/>
                                            <xs:element name="StdDev" type="xs:double"/>
                                            <xs:element name="Averages" type="xs:int"/>
                                            <xs:element name="AudioLevel" type="xs:int"/>
                                            <xs:element name="Latitude" type="xs:double"/>
                                            <xs:element name="Longitude" type="xs:double"/>
                                            <xs:element name="Time" type="xs:dateTime"/>
                                            <xs:element name="TimeUTC" type="xs:dateTime"/>
                                            <xs:element name="RotDirection" type="xs:string"/>
                                            <xs:element name="Heading" type="xs:int"/>
                                            <xs:element name="Selected" type="xs:boolean"/>
                                          </xs:sequence>
                                        </xs:complexType>
                                      </xs:element>
                                    </xs:sequence>
                                  </xs:complexType>
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                                </xs:element>
                              </xs:sequence>
                            </xs:complexType>
                          </xs:element>
                          <xs:element name="AudioData" type="xs:string" minOccurs="0"/>
                        </xs:sequence>
                      </xs:complexType>
                    </xs:element>
                  </xs:sequence>
                </xs:complexType>
              </xs:element>
              <xs:element name="Transcript">
                <xs:complexType>
                  <xs:sequence>
                    <xs:element name="ID" type="xs:int"/>
                    <xs:element name="StartTime" type="xs:long"/>
                    <xs:element name="EndTime" type="xs:long"/>
                    <xs:element name="Frequency" type="xs:double"/>
                    <xs:element name="SystemName" type="xs:string"/>
                    <xs:element name="Priority" type="xs:int"/>
                    <xs:element name="XMLSiteList">
                      <xs:complexType>
                        <xs:sequence>
                          <xs:element name="SiteModel" maxOccurs="unbounded">
                            <xs:complexType>
                              <xs:sequence>
                                <xs:element name="ID" type="xs:int"/>
                                <xs:element name="Name" type="xs:string"/>
                                <xs:element name="IPAddress" type="xs:string"/>
                                <xs:element name="IPPort" type="xs:int"/>
                                <xs:element name="AudioIPPort" type="xs:int"/>
                                <xs:element name="SerialNumber" type="xs:int"/>
                                <xs:element name="Type" type="xs:string"/>
                                <xs:element name="Latitude" type="xs:double"/>
                                <xs:element name="Longitude" type="xs:double"/>
                                <xs:element name="Frequency" type="xs:double"/>
                                <xs:element name="Color" type="xs:string"/>
                                <xs:element name="Receiver" type="xs:string"/>
                                <xs:element name="IsPrimary" type="xs:int"/>
                                <xs:element name="Size" type="xs:int"/>
                                <xs:element name="HardwareVersion" type="xs:string"/>
                                <xs:element name="SoftwareVersion" type="xs:string"/>
                              </xs:sequence>
                            </xs:complexType>
                          </xs:element>
                        </xs:sequence>
                      </xs:complexType>
                    </xs:element>
                  </xs:sequence>
                </xs:complexType>
              </xs:element>
            </xs:sequence>
          </xs:complexType>
        </xs:element>
      </xs:sequence>
    </xs:complexType>
  </xs:element>
</xs:schema>
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9.3. Maintenance

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

9.3.1. Backup

It is recommended to back up the database on a regular basis in case of database corruption.  To back up the 
database press the Backup button on the Database tab in the ribbon menu.  The dialog below will be shown

Select the database to be backed up and press Open to display the Saved Menu.

Select the folder (directory) in which to save the database and press Save.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

9.3.2. Import

To import data press the Import button on the Database tab of the ribbon menu.  Select the file to import and 
the data from the file will be imported into the database.

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

 
          

9.3.3. Restore

Select to restore the database entries from a previously exported .ttdf file.
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9.3.4. Repair

Use this feature to repair a database that may be corrupted.
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10. Scan and Search

TargetTrack 4 can program the AOR DV1 or the ICOM R8600 receivers to search or scan frequencies.  If either 
of these receivers are being used, the Scan and Search tab will be shown on the menu ribbon.

A search consists of a starting frequency, an ending frequency, and a frequency step.  When the search is 
initiated the receiver begins at the starting frequency moves up in frequency by the step frequency until it 
receives a signal.  Once a signal is received TargetTrack 4 will tune all the other receivers on the network to the 
received frequency and begin to take and display data.   When the transmission ends the search resumes.  
Additionally, if the receiver stops on an undesired frequency, that frequency can be added as a pass frequency 
and the receiver will no longer stop searching when a signal is received on the pass frequency.

A scan consists of a list of frequencies entered by the user.  The receiver will scan through these frequencies 
and stop when a signal is received.  When a signal is received TargetTrack 4 will tune all other receivers to the 
frequency and begin data collection.  When the transmission is complete the scan will resume.

The discussion below will explain the data entry required to initiated searches and scans.

The figure below shows the Search and Scan tab from the ribbon menu.

Search
To initiate a search enter the start frequency, the end frequency, and the step frequency and press Start.  If the 
receiver stops on a frequency that you do not want to collect data, press the Pass button and the frequency will 
be entered into the pass frequency list.  The list can be edited by selecting a frequency from the list and 
pressing clear.  The Clear All button will remove all the pass frequencies.  When searching the Start button will 
turn into a Stop button.  Press the Stop button to conclude the search.

Scan
To scan a number of different frequencies, press the Edit Memory Banks button to display the following dialog
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Click the Download Memory Bank button to download frequencies already stored in the receiver.  The figure 
below shows an example of a download.

To add a frequency to the list, simply type it in at the end of the list and press the Tab key.

To delete a frequency, select it and press the Delete key.

To erase the entire bank, press the Erase Bank button.

Up to 10 banks with 50 frequencies in each bank can be programmed.

To initiate a scan simply press the Start button.  To terminate the scan press the button again.
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11. Targeting

TargetTrack 4 can identify and track multiple targets.  The positions of the targets are displayed on the map as 
a point surrounded by an ellipse.  The point represents the estimated position of the target and the probability 
ellipse indicates there is a 95% probability that the target is somewhere within the ellipse.  The Target display 
on the Home tab gives the location of the target and the CEP (circular error probable).

The display depicted below shows two targets

In this display Target 2 is the active target, Target 1 was an earlier estimated target.

On the Home tab of the menu ribbon the parameters of the active target are shown as demonstrated below

Clicking on Target 1 will display the parameters of this target as shown below.

The targets can be deleted by pressing the Delete button next to the display or by selecting the target and 
pressing the Delete key.

All of the targets can be deleted by selecting one of the targets and pressing Shift + Delete.

When a signal is not present the targets will remain on the display.
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12. View

The view pane on the Home tab of the ribbon menu can be used to customize the display of the targets and 
the bearings.

Show Bearings

Select Show Bearings to display the bearing lines on the map.  If this is unchecked no bearing lines will be 
shown.

Show Target Location

Select Show Target Location to show the estimated target location as calculated by TargetTrack 4.  If this is 
unchecked the target location will not be displayed

Show Target Estimates

Each time a new bearing is received an instantaneous target estimate is calculated.  If this item is checked each 
target estimate will be shown as a black dot.  The dots will fade as the age of the Target increases.

Show Average Bearings

A running average of the bearings is used to calculate the average target location.  If this is checked the 
average bearings will be displayed

Show Target Ellipse

Checking this button will display the uncertainty ellipse for the target.

Averages

The averages parameter sets the number of bearings that are averaged to calculate the estimated position of 
the target.  Use a large value (~30) if the target is stationary or moving slowly.  Decrease the averages for a 
fast moving target (~ 5 - 10).
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13. File

When TargetTrack 4 is started, it will revert to the state it was in the last time it was ran.  The file menu on the 
left side of the ribbon menu allows the user to save and open mission files.  These files can be moved to a 
different computer if desired.

New Mission

Select New Mission to begin a new blank mission.  A new mission dialog will be displayed. (See below)

Open Mission

Open Mission allows the user to open a saved mission.

Save Mission

Select Save Mission to save the current TargetTrack state.  Saving a mission will save all the sites, the beacons, 
and the map selections.

Save Mission As

Performs same as Save Mission except it allows the user to select a file name

New Mission Dialog

Name of New Mission

Type in the name of the new mission

Database to Use

Select the database you want to use to store the receptions.  To add a new database, type in the name of the 
database you want to use.  Note: Typically this database does not need to be changed.  If changed, 
when using this mission, only the receptions collected using this database can be played back or 
accessed via the Data tab.

Press to create new mission

Pressing this button creates a new mission.  All sites will be deleted; however, you will be prompted to 
determine if you want to save your current beacons and placemarks.
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14. Virtual Sites

Virtual sites can be used to manually enter bearings.  To add a virtual site select Virtual from the Add Site menu 
on the Site tab or right click on the map display and select New Virtual Site

The site will be displayed on the map as shown below

Select the virtual site and on the Sites tab enter the name, frequency, and the bearing of the virtual site.

When the primary site receives a signal the a bearing line will be drawn from the virtual site, as shown below.
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15. Placemarks

Placemarks may be added to the map to denote places of interest.  To add a placemark select Placemark from 
the Add Site menu on the Sites tab of the ribbon menu or right click on the map and select New Placemark.  
Using the mouse drag the placemark to the desired position.  On the Sites tab enter the name of the placemark 
and select the icon to be used for the placemark.
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16. Measuring Distances on the Map

You can measure the distance from one point to another on the map.  To measure a distance, press the Alt key 
on your keyboard and then use the mouse to draw a line from the starting point to the ending point.  The 
length of the line will be displayed below the map in the center.  The line will persist as long as the mouse 
button is pressed.
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17. Limiting Target Area

If you know that the transmission source you are trying to locate is in a general geographic area, you can limit 
the area in which TargetTrack 4 will collect and display the bearing data and targets.  This can be very helpful 
when monitoring busy frequencies. Targets not falling into the area will not be recorded. To enable this 
feature, hold down the shift and alt keys and use the mouse to draw the area of interest on the map.  

If there is only one site, then the bearings measured by the direction finder will only be displayed and recorded 
if the bearing lines intersect the area on the map.  If multiple direction finders are being used, then TargetTrack 
4 will only display and record data if the estimated target location is inside of the area.

The area can be resized or dragged to a different location.

To remove the area place the mouse over the area and press the Delete key.
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18. Bug Reporting

If you are experiencing a problem with the software or would like to see a feature added please send an e-mail 
to brendah@dopsys.com.

When reporting bugs be as thorough as possible in describing 
· What happened
· What you were doing or trying to do when the bug occurred
· What state the program was in (e.g recording a reception, no bearing received, accessing the database, 

playing a previously recorded reception etc.)
· Screen shot if possible of the error
· Please attach the log file.

To get a log file go to the far right top of the ribbon menu and press the ? button

Select Get Run Log and save the file.  Attach this file to the e-mail.
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19. Support

Support for TargetTrack 4 is provided by telephone during regular business hours 7:00 am to 4:00 pm 
mountain standard time M-F or by email.

Contact:  Doppler Systems Support
Telephone: 480-488-9755
e-mail: brendah@dopsys.com
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